
Release Notes for Modo 12.1v1
Release Date

June 21, 2018

System Requirements

Officially Supported Operating Systems
• MacOS 10.11.x, and 10.12.x, 10.13.x (64-bit only)
•Windows 7,Windows 8, andWindows 10 (64-bit only)
• Linux 64-bit operating system (CentOS/RHEL 7+)

Minimum Hardware Requirements
• Intel processor(s), Core i3 or higher
• 1 GB available hard disk space (for Modo installation).
• 6 GB available hard disk space (for full content).
• At least 4 GB RAM
• Display with 1920 x 1080 pixel resolution
• Internet connection for product activation and online videos access
• The Advanced viewport mode requires an NVIDIA or AMD graphics card with at least 1 GB of graphics
memory and drivers that support OpenGL 3.2 or higher.

Recommended System Requirements

NOTE: This information is our best recommendation for the average user. Requirements vary by
usage, and individual usersmay have different requirements from those listed here.

• 2.5+ GHz quad-core processor
• 250+ GB disk space available for caching and temporary files, SSD is preferable
• 16GB RAMwith additional virtual memory*
• Display with 1920 x 1080 pixel resolution
• An NVIDIA or AMD graphics card with the latest drivers
• 2+ GB of graphicsmemory
• OpenGL 4.4 or higher support
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*The use of virtual memory improves stability and helps prevent data loss on large projects.

TestedWorkstation Hardware

The configurations listed below are those that Foundry have tested with Modo. Due to the constantly changing
nature and wide variety of computer hardware available in themarket, Foundry is unable to officially certify
hardware. The list below can be used as a recommendation and does not guarantee that it meets your particular
needs.

Please download and install the latest graphics driver from the NVIDIA or AMD websites. Make sure that you
are using 8.982.8.1 drivers or higher for AMD cards.

If you encounter any issues, please visit the Support Portal at https://support.foundry.com.

Tested Workstation Hardware

Apple • MacBook Pro 2017
• MacBook Pro (Mid 2015)
• MacBook Pro 2014
• MacPro (Late 2013)
• MacBook Pro10, 1
• MacPro4, 1
• MacPro5, 1
• iMac13, 2

Dell • Dell T1700
• Dell T3610
• Dell T3620
• Dell T5810
• Dell T7610
• Dell T7910
• Dell Precision 3520
• Dell Precision Rack 7910
• Dell Precision 5510
• Dell Precision 5520
• Dell Precision 7710
• Dell Precision 7720
• Dell M2800
• Dell M6800
• Dell XPS 15 9560

HP • HP Z800

| Release Notes for Modo 12.1v1
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Tested Workstation Hardware

• HP Z640
• HP Z620
• HP Z600
• HP Z440

Tested GPU Hardware

AMD Prosumer Graphics Cards • Radeon™ HD 1900 XT
• Radeon™ HD 2400 XT
• Radeon™ HD 2600 Pro
• Radeon™ HD 3870

AMD Enterprise Graphics Cards • FirePro™ D700
• FirePro™W4170
• FirePro™W5000
• FirePro™W8000
• FirePro™W2100
• FirePro™W5100
• FirePro™W4100
• FirePro™W7100
• FirePro™W8100
• FirePro™W9100
• Radeon Pro 560
• Radeon ProWX7100
• Radeon ProWX5100
• Radeon ProWX4100
• Radeon R9M370X

NVIDIA Prosumer Graphics Cards • Geforce GT 750M
• Geforce GTX 680
• Geforce GTX Titan
• Geforce GT 650M
• Geforce GTX 1080 Ti
• Geforce GTX 1080

NVIDIA Enterprise Graphics Cards • Quadro® K6000
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Tested GPU Hardware

• Quadro® K5200
• Quadro® K5000
• Quadro® K4200
• Quadro® K4000
• Quadro® K2200
• Quadro® K2000
• Quadro® K1200
• Quadro® K600
• Quadro® K620
• Quadro®M5000
• Quadro®M4000
• Quadro® P4000
• Quadro®M620

NVIDIA Quadro Graphics Cards: • P400
• P600
• P1000
• P4000
• P5000

New Features

Advanced Viewport Improvements

Full Shader TreeGroup Layer Support

The Advanced 3D viewport has seen some significant improvements in 12.1 allowing you to render muchmore
complicatedmaterial setups directly in the Advanced 3D viewport andmake changes in real time. The
Advanced 3D Viewport now fully supportsGroup Masks allowing you tomaskmultiple material layers so you
have the ability to render highly complex, multi-layeredmaterial setups.

Also, the Advanced 3D viewport now fully supports groupmask Blend Mode andOpacity changes, resulting, in
most cases, in little difference between the representation of amaterial in Advanced 3D viewport and the
representation of amaterial in Modo’s Preview Viewport.
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Animation Improvements

NewDriven Actions

Modo now supports driven actions, which gives you the ability to key an action through a single channel. This
allows you to re-time actions, create time warping effects, and alsomanipulatemultiple actions together in the
timeline. A number of new Driven Actions options have been added to the Actions palette.

Graph Editor Improvements

NewBox Scaling Tool

TheGraph Editor now has a new Box Scaling tool, which allows you to scale andmovemultiple selected
keyframes.
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NewSmooth Flat Slope Type

A new Smooth Flat slope type has been added to the Graph Editor to improve interpolation between keys. It
adjusts the tangents as the key value approaches surrounding keys to avoid an over shoot. This is the default
slope type for new keys.

Modeling and Asset Creation

Curve Particle Generator Updates

Along with some bug fixes, the Curve Particle Generator tool's Properties interface is now split into two
separate vertical tabs, CPG Distribute and CPG Control.

In addition, the following new Curve Particle Generator options have been added to improve your workflow
whenworking with particles:

• Point Mode > Exact Distance - Sets the exact distance between particles. The last point disappears
when it pushes off the edge of the curve.

• Particles ID Mode - Allows you to set the particle ID mode: Span Each Curve, Span All Curves, or
Random.

• Alignment Mode - Allows you to align particles using one of the following options: Automatic, Curve
Direction, Mesh Normal, Mesh Direction, or None.

• Reverse Axis - Reverses the direction of the particles based on the Forward Axis specified.
• Radial Position Jitter - Sets the degree of random variation in the position of each particle. Using this you
can create an uneven distribution of particles.
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• Rotation Jitter - Randomizes the rotation of the particles along the curve.
• Scale Jitter - Randomizes the scale of the particles along the curve.

Curve Rebuild Tool Updates

TheCurve Rebuild tool now has a new Exact Distance option, which allows you to set the exact distance
between particles along a curve.

Edges to Curves Tool Updates

The Edges to Curves tool now supportsmultiple curves.

Gradient Save Preset Option

You now have the ability to save your Gradient Value/Color options as presets to use in other projects and to
share with others. The preset is saved to the Preset Browser Assets > Envelopes directory. Once saved, you
can later drag-and-drop this asset from the Preset Browser onto the Graphic Editor or Gradient Editor to apply it
to your scene.

Hard Edge Improvements

Vertex Normal Toolkit Updates

The Vertex Normal Toolkit interface has been significantly changed for Modo 12.1. It completely changes how
vertex normals are handled. Now you can deform and edit the geometry and your updates are now
automatically stored asModo's native smoothing without having to re-create your normalmaps. This new tool
palette allows you to quickly select hard and soft edges and select different types of geometry to apply your
selection to.
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Smoothing Groups Improvements

Modo allows you to create polygon set smoothing groups to ease your workflow whenworking on complex
models using the new Smoothing Groups Manager.

New Weighting Options for Materials

TheMaterial item has the following new weighting options:
• Normal Method - Specifies how to generate the geometric face normals using one of the following options:
Default or Newells.

• Sum Coplanar Polygon Areas - Adds up the effective areas of contiguous coplanar polygons.
•Weight by Polygon Angle - Influences the polygons to form a larger angle at that vertex.
• Crease by Smoothing Angle - Toggles creasing the shading of themesh by thematerial's smoothing angle.
• Smoothing Groups - Selects how to deal with smoothing groups using one of the following options: Off,
Crease, or Force.

• Crease by Hard Edges - Toggles splitting the smoothing of themesh by any hard edges.

MeshFusion Strip Enhancements

Additional options have been added to the Fusion Surface Strips feature added inModo 12. A new Strip Polys
Only option is available for the Fusion Item, which only evaluates and produces the strip geometry. The surface
mesh is not generated. Enabling this option reduces thememory usage.
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In addition, two new options have been added to provide greater control over the topology that surface strips
generate.
• Absolute Quad Length - In combination with the Strip Length Abs option, allows you to define the length of
each polygon in a strip on a global basis. This can also be overridden on a per strip item basis if required.

• Perpendicular Recovery - Controls how quickly strip crossing edges return to a perpendicular position near a
strip intersection. This gives you an incredible amount of control over the topology that MeshFusion surface
strips creates. Specifying this option produces clean geometry that can be utilized for any post Fusion
modeling with either direct or procedural tools.

Procedural Connected Selection

A new procedural Select Connectedmesh operation has been added to quickly locate connected geometry to a
polygon, vertex, or edge selection. ThisMeshOperation uses a previous selectionmethod, such as Select By
Index, to compute all vertices, edges, and polygons.

Procedural Convert Selection

The procedural Convert MeshOperation converts a component selection from the given type to another
component type, polygon, edge, or vertex, which is used by a procedural mesh operator downstream in the
MeshOperations list (stack). The original source selection is retained and new selections are added.

Procedural Edge Slide Tool

A procedural modeling version of Edge Slide tool has been added. The Edge Slidemesh operator moves
selectedmesh elements along their connected edges.

There are twomainmodes for this tool, Radial mode and Linear mode, which can be used depending on the
style of selection and intended result.

Procedural Edge Split Tool

A new procedural Edge Split tool has been added to select a set of edges and split themesh in two or more
patches. You can interactively update the Gap distance by changing the value.

Procedural Loop Selection

A new procedural Select Loop tool as been added to select a loop of either vertices, edges, or polygons based
on a previous selection operation in your Mesh Operations list.
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Procedural PolygonMerge Tool

A new procedural Polygon Merge tool has been added to take a connected selection of polygons andmerge
them into a single polygon. You can also apply this tool with any of the Select by Previous selection
operations.

Procedural Polygon Unify Tool

A new procedural Unify Polygons tool has been added tomerge two polygons into a single polygon when you
have two polygons that are in exactly the same space and the polygons share the same vertices.

Procedural Push Tool

A new procedural Push tool has been added tomove selected geometry along the selected item's normals.

Procedural Surface Constraint

A new procedural Surface Constraint tool has been added, which is based on theMesh Constraint
Background option. Use this tool to procedurally constrain geometry to another piece of geometry in your
scene.

Render Display Updates

To improve your workflow, we have added a new button to access the Render Display viewport while working
in any layout.

Render Film Roll

Wehave added the FilmRoll option to the Camera item for 2D camera rotation. The results are displayed in the
3D Viewport when the animation is played.

Replicator Improvements

A new Use Polygon with Connectivity option has been added to the Replicator Item, which generates a
replica for each polygon, positioned at the center of each polygon, and aligned with the polygon's normal
directions. Thismode looks at how then polygons are connected rather than the point order. Additionally, it
aligns X and Z direction of the particle axis to neighbor connecting quad polygons.
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Symmetrize Tool

A new direct modeling version of the Symmetrize tool has been added to delete half of a mesh andmirror the
opposite half in its place.

Texture Locator Tool Updates

Texture Locator now has a new Front Culling option to create a texture shadow that onlymaps the parts of the
geometry directly seen by the camera.

Modo VR

Modo VR is now integrated intoModo 12.1v1 and we have a new VR layout, which allows first person
manipulation of layout, annotations, playback, and review directly in Modo in VR. Modo VR is built on theModo
Advanced Viewport technology, using a VR headset to let youmodel in real life scale and perspective.
Reviewing content in VR directly via Modo greatly reduces time needed to switch applications, and greatly
improves the overall immersion and connection an artist haswith an object’s scale and perspective.

UV Pack Improvements

A new algorithm has been implemented resulting in faster packing times and UV map coverage ratio
improvements. The new algorithm now does better optimization for packing concave island shapes.
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A number of new options have been added to the UV Pack tool for this release.
• Gap by Pixel - Sets the padding by image pixel unit, allowing you to accurately control the distance between
UV islands and UV borders.

• Polygon Tag - Enables you to select aMaterial, Part, Smoothing Group, or Selection Set option to group
UV islands by a polygon tag type to separate UDIM spaces.

• Background Constraint - PacksUV islands into the empty spaces available. Scaling it to the UVs in the
background.

• Pack UVs to New Map - The original UV map is retained and individual UV maps are created for each
specified polygon tag type.

Bug Fixes
• Viewports: Advanced viewport - MSAA- Blend edgeswith background image.
• BUG ID 28267 - Modeling: The Dimensions tool caused issueswith mirroring using an element action center.
• BUG ID 32561 - Viewports: Polygon smoothing was incorrectly applied to some smoothing groups.
• BUG ID 36412 - Replicators: Loading scenes or mousing over Proxy items in the 3D viewport causedModo to
randomly crash.

• BUG ID 42085 - UI: Localization issueswere found in theWavefront Object Load options form.
• BUG ID 43183 - Viewports: Smoothing Groups didn't smooth properly.
• BUG ID 43524 - UI: Collapsed dividers in formswere not persistent.
• BUG ID 45620 - Topology: The Topology Pen constantly snapped to things.
• BUG ID 46100 - Modeling: The Dimensions tool didn't show dimensions for a deferredmesh bounding box.
• BUG ID 48617 - Preview Render: Preview was unable to save Images over 8k x 8k.
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• BUG ID 49297 - MeshFusion: Modo prevented the deletion of MeshFusion Item instanceswhen outputting a
FusionMesh.

• BUG ID 49585 - UI: Child window from theQuick-Access popover did not pin unless the Quick-Access
popover was pinned first.

• BUG ID 50149 - Shader Tree: Itemswere sometimes incorrectly un-parented for the Render item.
• BUG ID 50387 - Presets: Replacing amaterial by dragging-and-dropping onto amesh in the 3D viewport from
the Preset Browser deleted the Diffuse Color image.

• BUG ID 51423 - UI: Unnecessary additional space was at the bottom of popovers.
• BUG ID 51830 - UI: Tool properties popover was sometimes too wide.
• BUG ID 53623 - Procedurals: Editingmeshes used by hiddenmeshes that havemesh operationswas
sometimes slow.

• BUG ID 53758 - UI: Switching to the Beta layouts and back lost user customizations.
• BUG ID 54089 - Procedurals: The Curve Rebuild tool was not accurate enough.
• BUG ID 54458 - Modeling: Element falloff selection no longer worked with a dimension tool when it overlapped
edges.

• BUG ID 54499 - SDK: MeshPolygon.triangles returned triangle indices as Longs rather than Ints.
• BUG ID 54902 - Procedurals: Editing the sourcemesh of a CloneMeshOp did not update the clones.
• BUG ID 55309 - File I/O: Loading aModo 10.2v2 scene using a number of procedural selectionMeshOps
causedModo to crash.

• BUG ID 55783 - MeshFusion:When putting some extraneous items bymistake into the Strips folder, Modo
generated an exception error and produced a yellow screen.

• BUG ID 55962 - Dynamics: Applying aMesh Shatter on a Plane created emptymeshes for the shards.
• BUG ID 55995 - File I/O: Autosave did not work as expected.
• BUG ID 56068 - Topology: Smooth Brush broke if you tried to adjust brush radius first.
• BUG ID 56080 - SDK: CLxImpl_CustomMaterial::cmt_SetSmoothing was not included as an output
parameter for the Use Polygon Area option.

• BUG ID 56283 - Particles: The Particle Sievemodifier tool behavior did not work as expected when sieving
particles along a curve.

• BUG ID 56306 - Fur: BakeGL Fur to Guides did not work.
• BUG ID 56421 - Viewports: Viewport Textures were disabled when a camera view was opened.
• BUG ID 56536 - Dynamics: Applying Geometry > Mesh Shatter > Cluster caused themesh item to
disappear, when secondary pieceswere set to 0.

• BUG ID 56537 - Dynamics: Applying Geometry > Mesh Shatter > Cluster, if secondary pieces had a negative
value, causedModo to crash.

• BUG ID 56567 - Modeling: The Spiral CurveMeshOp disappeared in the 3D viewport when selected in the
MeshOp list when the 3D viewport option RayGLwas enabled.

• BUG ID 56632 - Topology: Topology Penmode set to Fill did not fill.
• BUG ID 56684 - Replicators: Odd orientation issues occurred with the instanced geometry of a Replicator
item.

• BUG ID 56748 - Animation: Importing a BVH scene with an empty actor, without first adding an actor to the
scene, causedModo to crash.

• BUG ID 56754 - Deformers: Deformed instanceswith visibility disabled drew in the 3D viewport.
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• BUG ID 56840 - Procedurals: The Set Polygon TypeMeshOps corrupted existing UVs on using the Freeze
command.

• BUG ID 56932 - Deformers: The Bend Effector failed once the associatedmesh was used as a Fusion source
item.

• BUG ID 56939 - Modeling: Beveling with Thicken Polygon enabled andGroup Polygons disabled produced
the incorrect result until an option was changed.

• BUG ID 56975 - Animation: Adding a key to an embedded gradient with other channels also selected created
keys on those channels.

• BUG ID 56990 - Dynamics: Mesh Shatter > Radial caused a shard layer to be empty, which resulted in lost
mesh data.

• BUG ID 57007 - Modeling: The Dimensions tool did not correctly register multiple StaticMesh items.
• BUG ID 57024 - Particles: The Curve Particle Generator, with the Use All Curves option enabled, did not
work as expected.

• BUG ID 57030 Procedurals: TheMaterial TagMeshOp, combined with MergeMeshes, broke UVs.
• BUG ID 57052 - Dynamics: Mesh Shatter > Splinter created twice asmany shards than it should have.
• BUG ID 57053 - Modeling: Mesh Shatter > Splinter causedModo to crash when Number of Pieces was set
to 2.

• BUG ID 57064 - Bucket Render: Render artifacts were using a normalmap and fur material.
• BUG ID 57083 - Viewports: Record Playblast failed when usingWireframemode.
• BUG ID 57085 - Procedurals: Performance issues occurred with the Helix Generator inside a Radial Sweep
set to a high count.

• BUG ID 57136 - Deformers: Changing aGeneral Influence Type property and then setting the effector
causedModo to crash.

• BUG ID 57188 - UI: MacOS X only - Pressing the Delete keywhen renaming items, deleted the item rather
than deleting the text.

• BUG ID 57194 - Deformers: Loading an attached Falloff to a Deformer thread causedModo to crash.
• BUG ID 57262 - UI: Even when there were no Fusion items in a scene, theMeshFusion section always
displayed in the Properties panel.

• BUG ID 57279 - File I/O: FBX - Inconsistent import and export unit sizes occurred.
• BUG ID 57299 - Procedurals: Staticmeshes didn't work as inputs for mergemeshes.
• BUG ID 57300 - Animation: Zeroing a transformwith a tool active and applying an undo causedModo to crash.

NOTE: Note: This fixes the crash bug but introduces a new less crucial bug where the tool handles
don't update after undoing until the tool was reactivated again.

• BUG ID 57336 - MeshFusion: Creating a new Fusion item and undoing causedModo to crash.
• BUG ID 57384 - Viewports: - Creating a glTFmaterial did not transfer the Color channel to the glTFmaterial.
• BUG ID 57402 - Shader Tree: Dragging-and-dropping an image from the Clips list moved selected texture
layers.

• BUG ID 57403 - Particles: Applying the Curve Particle Generator using curveswith overlapping points
causedModo to crash.

• BUG ID 57417 - Particles: Displaying an image sequence for a Sprite, based on a Particle ID modifier, did not
display as expected.
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• BUG ID 57420 - Scripting: Windows/Linux only- Runningmesh.multiresImport on amulti-res file caused
Modo to crash.

• BUG ID 57468 - File I/O: Using an apostrophe character in a file name preventedModo from opening a scene
from the Recent Files list.

• BUG ID 57487 - Deformers: Morph influence visibility didn't drive its enabled channel.
• BUG ID 57595 - UI: Adding a new layout and switching the layout view, created a layout without a name.
• BUG ID 57609 - Particles: Applying a Point Count for Curve Particle Generator caused distribution and point
visibility issues.

• BUG ID 57636 - Modeling: Drawing a Bezier Curve on themesh surface causedModo to crash.
• BUG ID 57637 - Presets: Built-in brush presets didn't load images due tomerged base path changesmade in
Modo 12.

• BUG ID 57667 - File I/O: glTF export - Skinned animated glTF exports produced validation errors.
• BUG ID 57688 - Particles: When a non-manifold curve was fed into a Curve Particle Generator the particle
sourceswere not displayed.

• BUG ID 57708 - UI: Subtext in properties forms displayed over vertical tabs.
• BUG ID 57724 - Preview Render: Adjusting lights with preview open causedModo to crash.
• BUG ID 57735 - Viewports: Changing the SubD level in some large scenes caused severe performance lags
inModo.

• BUG ID 57765 - Procedurals: Point counts were off by one for the Curve Rebuild MeshOp.
• BUG ID 57772 - File I/O: Autosave did not work as expected.
• BUG ID 57790 - Viewports: Using the Advanced viewport with the Ambient Intensity set to 0 caused
recording of a playblast to fail when using Copy Source Settings.

• BUG ID 57797 - Shader Tree: Modo stopped force instancing itemswhen duplicating.
• BUG ID 57820 - Schematic: After selecting the Procedural Split Edges MeshOp, the Properties did not display
in the right panel.

• BUG ID 57849 - Modeling: Themiter handle displayed rather than the offset handle for the Edge Bevel tool in
the 2D views.

• BUG ID 57879 - Viewports: Interacting with a scene containing a large n-gon caused slow performance.
• BUG ID 57888 - Procedurals: MergeMeshes flipped polygons from the replicator.
• BUG ID 57897 - Procedurals: Selection Ops didn't work with a SmoothMeshOperation.
• BUG ID 57902 - Preset Browser: Paths sometimes disappeared from the browser.
• BUG ID 57941 - UI: The Selection Set menu Remove from Set only removed one item inmulti-selections.
• BUG ID 57957 - UV: Symmetry failed on amesh item containingmultiple attached pieces.
• BUG ID 57979 - Modeling: Symmetry didn't respect the local axismode.
• BUG ID 57986 - Painting: Painting weights with Live Deformers disabled didn't update the weight maps in the
3D Viewport until pen-up.

• BUG ID 57989 - Particles: Staticmeshes no longer generated particles as surface emitter surfaces.
• BUG ID 57990 - Particles: Surface particle generators didn't work with staticmeshes.
• BUG ID 58018 - Modeling: Changing an option inMesh Paint deleted the last mesh painted.
• BUG ID 58024 - Procedurals: PolygonMeshOps nameswere not consistent.
• BUG ID 58025 - Procedurals: Painting weights on a weight map controlling a procedural falloff causedModo to
crash.
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• BUG ID 58026 - Modeling: Bezier curves produced incorrect results when used with Radial Sweep.
• BUG ID 58043 - UV: UV Relax handles flipped polygons and caused arranged islands to break apart.
• BUG ID 58067 - Procedurals: Curve Rebuild did not close closed curves.
• BUG ID 58075 - UV: TheMeshOp Edge > Grow / Shrink did not work in the UV viewport.
• BUG ID 58079 - Modeling: Mesh Paint set to Mesh Preset Layer didn't drop themesh with each click.
• BUG ID 58087 - Scripting: String I/Owas broken in Python.
• BUG ID 58088 - UI: The Triple button had the wrong tooltip.
• BUG ID 58089 - UI: Snapping had a typo in the tooltip.
• BUG ID 58092 - File I/O: Exporting a scene to glTF format caused the scene to corrupt the skinning.
• BUG ID 58101 - Sculpting: Smudge and other sculpting tools were not working as expected.
• BUG ID 58103 - UI: Setting the Alert Dialog to Never and then navigating in the 3D viewport causedModo to
crash.

• BUG ID 58111 - File I/O: Alembic - Replicator geometry did not export.
• BUG ID 58115 - UI: Typing in a search field causedModo to crash.
• BUG ID 58130 - Viewports: Incorrect zooming occurred with staticmeshes in the scene.
• BUG ID 58140 - Animation: Playblast produced odd shading on subdivision geometry.
• BUG ID 58164 - Preset Browser: Manage Grid options did not work.
• BUG ID 58171 - File I/O: Exporting glTF texture layers without texture locators causedModo to crash.
• BUG ID 58175 - File I/O: MacOS X only - Opening .obj files with the Octane plugin installed causedModo to
crash.

• BUG ID 58192 - Color: The Set Curve Color command and button weremissing.
• BUG ID 58202 - File I/O: The Items list context menu wasmissing .gltf and .glb export descriptions for the
Export Selected Layer.

• BUG ID 58207 - Procedurals: Curveswere not generated for an edge selection set.
• BUG ID 58215 - Command Line: [/<field>/] output pattern failed.
• BUG ID 58221 - Bucket Render: Modo 11 and 12 had different rendering results due to smoothing changes.
• BUG ID 58228 - Shader Tree: Drag-and-Drop from the Images list onto the geometry in the 3D viewport didn't
assign the image layer.

• BUG ID 58237 - Topology: Falloff Radius setting for the Topology Pen tool broke when Symmetry was
enabled for vertices.

• BUG ID 58238 - UV: UV Pack failed to collapse the UVs to 0,0.
• BUG ID 58242 - Modeling: The Dimensions tool did not correctly register whenmultiple mesh layers were
selected.

• BUG ID 58244 - Viewports: Performance was poor for the Environment image display.
• BUG ID 58246 - File I/O: Loading large scenes inModo 12 causedModo to crash.
• BUG ID 58257 - Customization: Importing and exporting config files in Modo 12.0 causedModo to crash.
• BUG ID 58282 - Modeling: Unable to select elements using the lasso selectionmethod while Select Through
was enabled.

• BUG ID 58289 - Preview Render: Double-sidedmaterials did not render both sides.
• BUG ID 58298 - Viewports: Playblasts in the Advanced viewport rendered wireframeswhen theywere
disabled.
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• BUG ID 58302 - Preset Browser: Removingmultiple base paths fromPreset Browser and then saving the
config file causedModo to crash.

• BUG ID 58303 - Preset Browser: pbview.basePathRemoveAll did not work.
• BUG ID 58309 - Modeling: Applying a Push tool with a falloff on amorph did not behave as expected.
• BUG ID 58310 - Procedurals: Adding amesh item into a group linked to aMerge Mesh source input didn't
update automatically.

• BUG ID 58329 - MeshFusion: Using Duplicate as Subtractive Trim causedModo to crash.
• BUG ID 58355 - MeshFusion: Script error alerts occurred usingMeshFusion Strip Masking.
• BUG ID 58382 - UI: Form dividers were not displayed correctly.
• BUG ID 58390 - Viewports: In the Advanced viewport, the Environment lighting did not display.
• BUG ID 58399 - Viewports: Linux/AMD - LaunchingModo on some systems, initiated Advanced viewport
checks and causedModo to crash.

• BUG ID 58402 - Bucket Render: Some scenes created inModo 11 had distorted shadowswhen opened in
Modo 12.

• BUG ID 58420 - Procedurals: Linear Falloff did not effect Polygon Bevel MeshOp.
• BUG ID 58425 - UI: TheWireframe Opacity option was ignored when changing the InactiveMeshes Shading
Style viewport option and then setting theWireframe Opacity option.

• BUG ID 58440 - Viewports: Navigating was sluggish on high polymesheswhen using a NVIDIA Quadro card.
• BUG ID 58449 - Procedurals: The Axis Drill did not slice edges.
• BUG ID 58456 - Modeling: Translating an object with Intersection Snapping enabled causedModo to crash.
• BUG ID 58458 - Animation: Rotating an object from an imported .fbx file causedModo to crash.
• BUG ID 58527 - Viewports: Hit testing against a Curve Fill polygon causedModo to crash.
• BUG ID 58559 - Deformers: Resetting theWrap Influence causedModo to crash.
• BUG ID 58572 - Viewports: Performance issues occurred when applying smoothing, which caused
slowdowns for complex sceneswhenmaking shader tree changes.

Known Issues Specific to this Release
This section covers known issues and givesworkarounds for them, where appropriate.

Animation
• BUG ID 53661 - Selecting actions does not always select the correct one. This is caused by copying actions.

As a workaround, manually edit the tags on the broken actions by selecting them in theGroups tab, then save
and reload the scene.

Assemblies
• BUG ID 36452 - Assemblies exported from the Item List context menu result in poor visual layout of nodes on
import.
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As a workaround, you can save assemblies from the Schematic viewport.

Baking
• BUG ID 50671 - Baking displacement maps can cause UV seams to be visible, and the baked displacement
map to show quilting effects and other render artifacts.

• BUG ID 49437 - The Bake Channel Swizzling option can’t bake to texture alpha.

Color Management
• BUG ID 49244 - Windows only: With Perform Color Correction on, setting a default scene to a scene with a
mesh that has a position channel crashesModo at launch.

As a workaround, use System > Reset Preferences to reset to defaults or move/remove the default scene.

Command Line

• BUG ID 49514 - MacOS X only: Runningmodo_cl before running the UI Modo application breaks code
signing.

As a workaround, start the UI version of Modo once, before runningmodo_cl on any systemwhere you later
intend to use the UI version.

Deformers
• BUG ID 56726 - Deformed Instances that are off-screen are incorrectly drawn at the origin.

File and Image I/O
• BUG ID 56862 - Modo for SolidWorks Kit: Modo crasheswhen importing the same SolidWorks file twice in
oneModo session. This bug only affects import using the kit, not direct imports (File > Import).

As a workaround: Before importing a SolidWorks file for the second time, exit and restart Modo.
• BUG ID 50198 - Alembic scenes don't export some surface items, including staticmeshes and procedural
shatter items.

• BUG ID 49728 - Exporting selected layers (from the Item List context menu) to .fbx doesn't export instances,
unless the original mesh is also exported.

To resolve this, set the .fbx preference to Export Selection and use Export As….
• BUG ID 47036 - Color management in .svg images is not currently supported. This is a side-effect of a bug fix
where the largest allowable image size (64k x 64k) was always used when color correction was enabled.

• BUG ID 46962 - Rendering .svg images used as stencil maps for displacement or for layer masking can be
very slow.
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Fur
• BUG ID 35731 - Fur length textures can’t be edited with the Stretch tool.

Use different fur length drivers, such as hair guides or vector vertexmaps.

Input Devices
• BUG ID 51741 - MacOS X only: Modo sometimes becomes unresponsive when using the combination of a
click-drag in a tree view (for example, when toggling the visibility of two successive items in the Shader Tree),
followed immediately by a two-finger scroll gesture on some devices, including laptop trackpads and theMagic
Mouse.

As a workaround, change to a 3-buttonmouse (recommended to fully access all of Modo's features).
• BUG ID 35856 - Linux only: Plugging in aWacom tablet while Modo is running can cause undesired
movement. This cannot be fixed, due to a limitation of the hardware driver.

To avoid this, plug in the tablet before application startup or restart.

Item List
• BUG ID 53209 - Group creation (Ctrl + G) places the new group folder at a random position in the Item List, if
the items are not selected in a top down sequence.

As a workaround, select the items being grouped from top to bottom in the Item List before grouping (Ctrl +
G).

MeshFusion
• BUG ID 56973 - If a Trim Fusion role is assigned to an object and then it is dragged and dropped onto a
Primary, the dropmenu does not contain the Trim boolean options.

Pre-assigning themesh role is an unnecessary step. A new Trimmesh ismost easily added using drag & drop
and selecting Apply Intersect or Apply Subtraction from the dropmenuwithout first assigning a role to the
new mesh.

As a workaround, if a role has been pre-assigned, use either the Fusion buttons (Tool palette - Set Mesh Role
& Apply section) or PieMenu (Apply Subtraction or Apply Intersection) when initially adding Trims to each
Fusion Item (Trims can contribute tomultiple Fusion Items). If initially applied with either of thosemethods, all
subsequent Drag & Drop optionswill be supported.

• BUG ID 58642 - Attempting to change a Primary role will simply remove themesh from the Primary and not
change it to Trim/Un-Trim.
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Modeling
• BUG ID 32728 - Zooming out with a Space Navigator alters theWork Plane position.
• BUG ID 58620 - ​Hardening edges byUV boundary with partial UVs causesModo to crash.

As a workaround, be sure to fully UV amesh when hardening edges on a UV boundary.

Network Rendering
• BUG ID 48325 - Sceneswith image sequences rendered with Full Frames use the wrong image sequence
number on slavemachines.

As a workaround, use File > Consolidate Scene, then render the scene using a shared network folder
(Preferences option under Rendering > Network Rendering).

• BUG ID 36986 - Slaves render hiddenmeshes. Sincemesh hide state is not stored in the scene, when that
scene is transferred to the slaves, the state is lost. Themaster respects the hidden state, however.

As a workaround, if the intent is to avoid rendering, toggle the visibility for the item or render or open System >
Preferences > Rendering and disable Use Network Render Nodes.

• BUG ID 30318 - Network Rendering doesn’t support Realflow particles.
• BUG ID 25636 - Frame passes are not supported.
• Several Bugs - While it apparently worked inModo 902, in some cases, Network Rendering was not
implemented to support baking. Changes toModo in the 10-series apparently broke what wasworking for
some artists, so the functionality has been disabled.

As a workaround, Modo 10 implemented the ability to Network Bake using Bake Items and an external render
controller. For more information, please see the SDKWiki.

Node Shading
• BUG ID 50642 - Nodal shading does not support UDIMs.

Painting/Sculpting
• BUG ID 41682 - Textures are not always updating in Preview/Render when painting on an imagemap.

You can save and reload the image to force the update.

Particles
• BUG ID 44551 - Surface Particle Generatorsmay not update with changes to a Density Gradient Input set to
Slope.
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As a workaround, choose Distance to Locator or any other setting from the Density Gradient Input
dropdown, then change it back to Slope.

• BUG ID 34925 - Re-opening scenes saved with large particle caches can cause problems.

To avoid such issues, delete the cache before closingModo, or export the particles to .csv cache files or
Realflow .bin files. You can do this by attaching one of those nodes to the Particle Simulation item in the
Schematic viewport, and clicking Cache Simulation.

PreviewRender
• If a high polymesh is not visible, the Preview baking output will be incorrect.

As a workaround, reset Preview to fix the baking.

Procedurals
• BUG ID 56908 - Merge Meshes can corrupt UVs created inMesh Ops.
• BUG ID 56318 - Procedural duplication of MeshOps in a Deform folder creates errant Mesh Ops list.
• BUG ID 56317- Duplication of Procedurals does not work with the Select By Previous Operation tool.

As a workaround, manually edit the duplicate's Select By Previous OperationMeshOps.
• BUG ID 54738 - A duplication of any item that is aMergeMeshes Source (For example, aMesh Item,
Procedural Item, or Fusion Item), any duplicates (duplicate or instance) are added to theMergeMeshesOps
List as a source.

As a workaround, remove the unwanted additionalMergeMesh Sources (regardless of the type of source) in
theMesh Ops List using the X icon in that list next to eachMergeMeshes source.

• BUG ID 52149 - Curve Extrudemesh operation: The Path Segment Generator's Align to Normal option
doesn't work when using a Bezier with zero-length tangents.

As a workaround, rotate the polygons to point toward the +Z before extruding or make sure there are no zero-
length tangents.

• BUG ID 46512 - When rigged, Rock items and other procedurals do not display correctly in GL. This is a
limitation of the feature and will not be fixed.

You can use Preview or RayGL to visualize the variations from rigging.
• BUG ID 57855 - Non-active deformer leaves behind selected elements.

As a workaround, navigate the view to force an update.

References
• BUG ID 44492 - If a scene that already contains references is referenced, the shading of the original
referencesmay not persist.

As a workaround, limit sceneswith shading to one level of reference.
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• BUG ID 41119 - Reloading a reference after replacing it with the same file can causeModo to crash.
• BUG ID 56620 - Modo crasheswhen closing a scene containing a referenced scene after attempting to revert
a reference override.

As a workaround, first close and reopen the scene before attempting to revert the reference.

Rendering
• BUG ID 55663 - Motion Blur applied on a curve in aMeshOperation no longer works.
• BUG ID 53411 - Mesh lights or any direct light too close to a surface can produce fireflies (hot pixels) in some
cases.

As a workaround, use aMaximum Radiance higher than 1W/srm2 to reduce the bias.

• BUG ID 53793 - Rendering using a Dual CPU with 72 threadswas significantly slower than expected.

As a workaround, anymachine that hasmore than 32 cores, performance will be better if you limit rendering to
half the number of cores you have.

• BUG ID 53184 - Value presets created for material Subsurface Scattering samples in Modo 10.1 or earlier
now show on the render item instead.

• BUG ID 52730 - The Vertex Illumination Bake command doesn't work as expected, when themesh has
transform channels.

As a workaround, freeze the transforms in themesh properties.

Rigging
• BUG ID 27244 - Duplicating joints in a boundmesh retains influences from the original joint chain.

Scripting
• BUG ID 53458 - Right-clicking or running a script in the Script Editor can lock up input to Modo.

As a workaround, click in the top window of the Script Editor, use themainmenus, or change to another
application, then switch back toModo.

Shader Tree
• BUG ID 37858 - In the Shader Tree, choosing a group fromAdd Layer > Image Map > (use clip browser)
fails.

To work around this issue, in the Clip Browser, choose a single image instead of the group, and then change
to the image group using the Texture Layer's Properties tab.

• BUG ID 30947 - Layer masking displacement does not work unless you drag and drop themasking layer onto
the displacement layer.
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• BUG ID 57874 - CustomMaterials that define their own smoothing properties (such as the Skinmaterial), no
longer smooth themesh correctly.

Unreal and Unity Materials
• BUG ID 50701 - Unrealmaterial Ambient Occlusion does not bake correctly in Modo.
• BUG ID 50700 - There is no way to visualize the Unreal SubSurface Color effect in Modo.
• BUG ID 50451 - On some graphics cards, Unitymaterial may cause flickering in the Advanced viewport when
used with bumpmaps and shadows.

UI
• BUG ID 55759 - Transforming objects can cause the Items Properties panel to flicker.
• BUG ID 55571 - Resizing the dopesheet in Zen crashesModo 11.1, but not in Modo 11.0.
• BUG ID 55185 - Text in the viewport icon buttons is not visible in the Advanced viewport on someMac
OS/AMD configurations.

As a workaround: UpgradeMacOS to 10.12 or 10.13.
• BUG ID 44896 - Dragging and dropping an image from disk into the Clips list doesn’t work.

If the Clips list is empty, drop the image onto the bar at the top, otherwise drop it above or below other images
in the list.

• BUG ID 44496 - MacOS X only: Disabling Affect System Color Dialog in Preferences > Rendering > Color
Management, and using the system color picker caused colors to darken with each use of the color picker.

This is due to anOS X issue, which requires the color profile in both themonitor settings and color picker to be
set to sRGB IEC61966-2.1.

• BUG ID 43162 (Windows only) -Setting a custom text size affectsModo's text drawing.

As a workaround, go to the compatibility settings by right-clicking theModo shortcut or executable, and turn off
font-scaling for the application.

• BUG ID 57715 - Selecting items in the viewport does not always update the Properties form.

As a workaround, click the Alt key.

UV
• BUG ID BUG ID 58368 - OddUV Packing in attached scene - either it's all in the lower third if the UVmap, or
its all squashed in the left corner.

As a workaround, with the new UV Packing algorithm, the range of gaps are different than previous releases,
as the gap scalematches the actual UV space (to support gaps by pixel). For caseswith manyUV islands,
smaller valuesmust be used.
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Viewports
• Windows only: Using Raptr can causeGL driver crashes inModo.
• BUG ID 58721 - Removing a draw package, such asDimensions, from an itemwhile a tool is active causes
Modo to crash.

As a workaround, drop the active tool before removing the draw package.
• BUG ID 58655 - Moving default directional light is slow and laggy.

As a workaround, delete the default directional light from a new scene and add a new one.
• BUG ID 58586 and 58004 - Viewports: Modo took too long to navigate in the 3D viewport when the Replicators
were set to All. In addition, Modo's performance slowed down using the Default viewport when the polygon
count per frame changed after an NVIDIA profile was added.

A workaround to skip auto-loading of NVIDIA profile was added inModo 11.2v1. A more elegant solution will
be added in a future release.

Workaround steps:
1. Make sure there is no NVIDIA profile for Modo (delete one if it already exists).
2. Start Modo each time with the command line parameter -dbon:skipCreatingNVDriverProfile

This can be done by editing the Properties for the Desktop shortcut for Modo12.1v1 and by adding -
dbon:skipCreatingNVDriverProfile to the end of the target field.

NOTE: The workaround is for Windows only. This is known to affect at least someQuadro and
Pascal-based cards but may affect others.

• BUG ID 58424 - Viewport performance is worse when the layout doesn’t display a status bar.

As a workaround, in the NVIDIA Control Panel driver profile, enable Prefer maximum performance in the
Power management mode setting.

• BUG ID 58003 - GameNavigationmode (camera rotation) does not work in a floating 3D view (palette or
separate window).

As a workaround, useGameNavigationmode only in docked 3D views (views that are part of a Layout).
• BUG ID 57955 - Clicking on the VR layout tabmay crash when using a systemwith a RadeonWX-series
graphics card. This is due to a driver bug and should be fixed by a AMD in a future driver release.

• BUG ID 56706 - Unity and Unrealmaterials are not displayed correctly when first loaded into the Advanced
viewport.

As a workaround, enable and then disable the visibility of the Shader Tree textures.
• BUG ID 55816 - Wireframes are washed out on transparent surfaces in the Advanced viewport.

As a workaround, avoid transparencywhenmodeling or doing work where wireframes are needed.
Alternatively, use the Default viewport.

• BUG ID 49473 - Projections are incorrect if the projecting camera is set to Vertical film fit mode and the width is
less than the height.

• BUG ID 46995 - Ambient Occlusion display in the Advanced viewport is affected by selected itemwireframes.
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You can disable Show Selection in the Visibility options or disable wireframe drawing on the activemesh
layers.

RGBA textures only draw correctly in the Advanced viewport. In the Default viewport, any unsupported texture
effect on an imagemap is drawn as diffuse color when the layer is selected in the Shader Tree.

• BUG ID 43771 - Camera projections from non-render cameras show distortion in GL and baking.

To avoid this, make sure that the projection camera has a filmwidth-to-height ratio that matches themain
render camera.

Developer Notes
• BUG ID 53988 - SDK: The item.channel query didn't read evaluated strings correctly.
• BUG ID 55473 - SDK: A reference scene loaded twice did not return geometry in CLxSurfaceVisitor.Sample
().

• BUG ID 55749 - SDK: Viewing graph for a plugin's alpha channel, if no keyswere set, causedModo to crash.
• BUG ID 56467 - SDK: Reading an item graphs in a command's enable function sometimes causedModo to
crash if the scene changed.

• BUG ID 56697 - SDK: Rendercache crashedModowhen closing the scene.
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